
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Eye On The World 

 PHOTOGRAM 
 Monthly Newsletter of the Redlands Camera Club  

     October 2021 
 

                    Photogram Editor – Debra Dorothy 
               Deadline for entries is the 25th of every month 

 
Redlands Camera Club meets: 1st & 3rd Mondays, 7:00 pm  

Check http://www.redlandscameraclub.com for Zoom meetings 

                   Guests are always welcome 

         

           Photo by Jim Hendon 
 

ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not looked the way you 

expected? The problem is probably a difference in how your computer and the club projector display colors and 

brightness. You can fix this by calibrating your computer the same way our club calibrates our projector – with the 

ColorMunki. Set up is simple and the calibration process only takes a few minutes. Contact Carl Detrow at 

csdetrow@verizon.net  to reserve the ColorMunki. 

__________________________________________________________________________________________ 
 

Want to learn more about your hobby?  
Click the link below to go to B&H learning Video Site: 

Click HERE

http://www.redlandscameraclub.com/
mailto:csdetrow@verizon.net
https://www.bhphotovideo.com/explora/videos
https://www.bhphotovideo.com/explora/videos
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President’s Message – Russell Trozera 

  

 

 

Finding your groove and improving your photography. 

 

Photographer’s sometime struggle with defining themselves when it comes to what do I 

like about photography. Scott Kelby in one of his videos stated the following ideas. 

 

Find other people’s photos you like. (Stock photos, 500px, Google, Instagram, etc) 

 

Look at other people’s photography that you really like. 

 

Examine the image. Ask yourself the following questions 

 

1. Was the image shot wide or tall? (landscape or portrait) 

2. What type of lens was used? 

3. What type of lighting was there? 

4. What time of the day? 

5. What direction is the light coming from? 

6. What is the subject? 

7. What makes the subject interesting? 

8. Is there a tone to the image? (Cool or Warm etc) 

9. What was the F-Stop? 

10. How is it composed? 

11. What did they do in post-processing? 

 

What is it that moved you?  Light? Color? Composition? Location? Etc 

 

Then apply these to your images 

 

Look for the common thread/themes. Location, Lighting Perspective, time of day, subject look happy, 

background color, sunset light, simplicity, lighting on portrait, soft light, clean, expression, clothing, gesture of 

person, styling, great clouds, etc… 

 

Then make a list of the of the top 3 items in each of the images of why you liked the image 

 

Then combine the list. See what are the common things you listed 

 

Scott Kelby commented on the many workshops he has done many people ask the questions, what camera did 

you use? What F-Stops?  Shutter speed? What ISO?  What lens? 

 

His comment was, “It’s not the camera setting that makes the picture”.  I hope this information will help you 

find your groove, improve your photography and shoot what you love. 

 

  

 

  

Photo 

By  

Judith Sparhawk 
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Redlands Camera Club Photo Walk Oct. 2, 2021 

Redlands Camera Club is having a photo walk in Redlands celebrating 125 years since the 

founding of the Club in 1896. “Why I Love Redlands” is the theme of the photo walk. The 

photo walk will begin at Smiley Park in Redlands at 9 AM, Oct. 2, 2021. The public is 

invited to participate in this event.  Categories for the event are People, Places, Heritage, 

and Open / Miscellaneous related to Redlands. 

2. Redlands Photo Contest - Open to the public  

Four  Categories: People, Places, Heritage, Open/Miscellaneous.  All entries must be related to Redlands. 

Overall Grand Prize,1st, 2nd and 3rd Place Ribbons in each category 

All ages welcome. Photos can be taken with any kind of camera including, but not limited to, a Smartphone, 

DSLR, mirrorless, film or drone.  

Photos should be submitted no later than 11:30 PM, Tuesday, October 12, 2021 

No fee to enter. Only 1 photo per category, please. Email photos to redlandscameraclub@gmail.com 

From our sponsors, Gifts along with the ribbons 

Gift commitments from: 

 

Contact Creators Head Quarters build 5 page web site. $1500 value, recipient to pay for web hosting & Domain 

name, Contact Creators Head Quarters 1000 business cards.  Designed , Printed & delivered. Image One Gift 

Card $ 150.00, Image One Gift Card $100.00, Image One Gift Card $50.00. Image One, Free Equipment rental 

$75.00 Value  Recipient to pay insurance and Deposit , Deposit refundable. Image One 11x 14 print.  IEPPV.  3, 

1 year memberships. Redlands Art association 1, 1 year membership, Redlands  Camera Club 1, 1year 

membership 

 

 

Photo by Jim Hendon 

 

mailto:redlandscameraclub@gmail.com
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Competition Chair – Carl Detrow 

 

Competition 
2021 Winter Competition 

 

Traditionally, the Redlands Camera Club has had three competitions a year, the 

first Mondays in April, July, and December. We also used to hold a catered or 

potluck banquet on the third Monday of those months for awards nights. The 

world has changed, to say the least, and we’ve been forced to drop the banquets, 

but still present the awards. Putting on the awards night banquets has been a lot 

of work for many dedicated club members, but maybe we can do them again 

someday. Covid willing. 

 

Our next competition is planned 

for Monday, December 6, 2021, 

on Zoom. 

 

The competition is open to 

Redlands Camera Club members 

only. Entries will be accepted on 

the website from November 3rd 

at 11 PM until the 17th at 11 PM. 

Awards will be presented on 

December 20, hopefully in a live 

meeting. Cost is $10 for 1 or 2 

images, collected through 

PayPal during the entry process. 

 

Competition classes and 

categories are listed on the 

website. Image competition 

guidelines 

(redlandscameraclub.org) 

Category X for this competition 

will be “Reflections.” It’s up to 

each entrant to decide what 

“Reflections” means. We’ve seen 

some beautiful landscapes 

reflected in mountain lakes, and 

even some cityscapes reflected 

in skyscrapers and car hoods. 

What’s your idea for a 

reflection-themed image? 

 

Images must be in jpg format, 

color space of sRGB, and no 

more than 4,000 pixels on the long side, resolution not to exceed 200 PPI. If possible, images should 

be a maximum of 3.5 MB. 

 

We look forward to seeing your images in November.  

 

Good luck! 

 

Carl Detrow 

 

http://redlandscameraclub.org/image%20competition%20guidelines.htm
http://redlandscameraclub.org/image%20competition%20guidelines.htm
http://redlandscameraclub.org/image%20competition%20guidelines.htm
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Mentoring Chair – Rick Strobaugh 

 

 

 

September 20 Panel Discussion: 

 

Last meeting, we had several club members discuss the things that got them to 

where they are in photography, what motivates them and how to become a 

better photographer. 

 

I thought I would touch on their comments for those who were not able to 

attend the Zoom meeting. One of the points that most made was that you 

should photograph what you really enjoy shooting. If you are enjoying the 

subject or area, you will shoot more often and spend more time shooting it. It is 

always good to keep going back to favorite places since lighting, weather, seasons and conditions are 

always changing. 

 

Also, look at other photographer’s work to give you new ideas of capturing photos, especially in the 

way of compositions and subject matter. Shoot different compositions with wide angle to telephoto 

along with at different heights. Sometimes, an Intimate Landscape, zoomed in, can be more powerful 

than a wide-angle coverage of more area.  

 

The ideal is to make an emotional contact with the viewer of your photos. Going out with other 

photographers can also be very educational by watching what they are doing. That is why attending 

the club fieldtrips once they start up again, can help a lot. Not only in watching but also the 

photography related conversations. 

 

Try shooting new things too. This may open doors that you didn’t know anything about in 

photography. If you don’t enjoy it, fine, go on to something else. But you just may discover another 

favorite to become involved with.  

 

Also, know your camera. Know how to work it to get different results. Don’t just shoot on Auto. Read 

the manual or watch videos on operating your camera. This helps you develop your own “Style”. 

 

One of the biggest suggestions by the panel was 

very simple, practice, practice, practice. 

 

 

 

 

 

Photo 

By  

Judith Sparhawk 
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S4C Chair – Deborah Seibly 

 

 

On September 18th, S4C held a virtual annual banquet. Pandemic uncertainty impacted 

the timing of the banquet which is usually held on site in June.  

 

During the 2020-2021 competition year, 3657 images were received from members of 

the 17 participating clubs. 317 awards and 698 honorable mentions were awarded for a 

total of 1015. These winning images were then entered into the End of Year (EOY) 

competition. Of these 1015 images, 144 medals, 254 honorable mentions and 11 Best of 

Shows were bestowed at the EOY. HM’s and medals are awarded in each category for 

each skill level (as it is in the RCC) but the Best of Show can come from any skill level (again as in the RCC). 

 

It is also at the EOY that participating members are “ranked” in each category and skill level based on a 

cumulative score for the image maker’s 12 highest scoring images. 

 

I am proud to say that those members of the RCC that participated during the competition year did very well. 

One club member, Stan Fry, did exceptionally well. Following are the results in each category: 

 

Pictorial Division: 

Individual Color -Ken Randall received a Gold Medal, level A. Stan Fry received 1 HM, level E 

Monochrome -Ken Randall received 1 HM, level AA 

Arranged Monochrome -Stan Fry received a Bronze medal for achieving 3rd place in this category for skill level 

E. Deb Seibly won 2 HM’s level E 

Creative- Stan was awarded an HM for level E 

 

Photo Travel Division: 

General- Deb Seibly received a Gold medal level AA 

 

Nature Division: 

General- Deb Seibly was awarded 2 HM’s level A. Stan really swept his skill level in this category! He received 2 

HM’s but also received the Bronze, Silver and Gold medals for level E. In addition, he received a Gold medal for 

his first place ranking in Nature General Level E. Congratulations Stan. 

 

Wildlife- Christine Cope-Pence earned an HM in level AA. Stan received 1 HM and a Bronze medallevel E.  

 

Photojournalism Division: 

General-Stan received 2 HM’s and, again, a Bronze medal level E. 

 

I hope I have not missed anyone as I am compiling this report before the results are posted on the website. If I 

have, I will make amends next month.  

 

The S4C 2021-22 competition year has begun. The October competition is now open and will take submissions 

until midnight, October 9th. I encourage club members to enter and broaden your photo world a bit. Please 

contact me by email if you have questions-dlseibly@gmail.com. 
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Photo 

By  

Debra Dorothy 
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  Program Chair – Donald Purdey 

 
Redlands Camera Club Program 

 
November 1, 2021 

 
Preparing Your Images for Print, by Nic Stover 

 

 
 

This has been one of Nic’s most popular presentations. The art of printing can be an overwhelming task, but it is extremely rewarding, 

enabling you to see your images on the wall or to have the confidence to sell your work to others. He will help us assess what images 

are ready for print and what changes we might need to make to get the others ready, including how to sharpen, resize, and brighten 

our images so that what we receive in the mail is what we saw on our printer screen. 

Here is what will be covered: 

1. Learn through a review of the top mistakes made in printed images. 

2. Explore color calibration on your computer screen and why it is so important.   

3. Get an in-depth look at cropping and what are the standard print sizes we should consider.   

4. Examine various print materials we might consider and what types of images look good on each of them.  For example, if we 

are considering printing on wood or acrylic, what would look good for each of them? 

5. Hear Nic’s past experiences from trying different print companies and who are the various print companies he would 

recommend and who he would not recommend. 

6. Explore more about what color spaces we should be working in and how to use ICC profiles, etc. 

7. Learn from Nic’s demonstrations of the best ways to sharpen and resize your images. 

8. Receive step by step demonstration of how Nic prepares his images for print.   

 

In this session Nic will prepare a 16x20 metal print for printing from one of our camera club members. Yes, one of us will get a free 

16x20 metal print of their work! More on that later.  

2. About Nic Stover-  

Nic Stover was raised in the high mountains of Western Colorado on a single magazine subscription to National Geographic and only 5 

television channels. The only shows his family regularly watched were Nature (PBS) and the Tour De France. It was here that his love for 

adventure, the outdoors, and photography took shape. 

Nic is now based in San Luis Obispo, California. He focuses on landscape photography classes and workshops, encouraging his class 

participants to Develop their skills, Explore their capabilities, and to Create meaningful work.  

Nic Stover Photography exists to help photographers understand the unique perspectives that assist in the discovery of their 

capabilities, while enabling a deeper connection with themselves and others through creative expression.  Through his classes, webinars, 

tutorials, and presentations, Nic works with people of all ages, backgrounds, experiences, and desires focused around a dialog on how 

they can thrive in their own unique creative and artistic process.    

His landscape photography work has taken him across the globe — from the backcountry of Greenland, to the windswept mountains of 

Patagonia, and the frigid extremes of Alaska.  His portfolio of work encompasses desert, ocean, night, and mountain photography.  Nic 

also enjoys showcasing the amazing the places that are unique to the Central Coast of California, from sea caves to sand dunes, and its 

dramatic landscapes. 

Additional information can be found at www.stoverphoto.com 

 

 

 

 
 
 
 

https://www.stoverphoto.com/
http://www.stoverphoto.com/
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Redlands Camera Club Program 
November 15, 2021 
 

Presentation: Ferrari Club of California-Yosemite 
Grand Tour 
 
 
The Ferrari Club Tour IV was held in June, 2019. 
Twenty Ferraris, of various models and vintages, worth 
about 5 million dollars, assembled at the Hyatt 
Regency in Valencia, then went to the Visalia Country 
Club, where they were displayed on the golf course’s 
lawn. Then they went on to Yosemite. The sight of 20 
thundering Ferraris was spectacular, and people had 
their cell phones out recording the spectacle. Their tour 
included Glacier Point, the famed Ahwanee Hotel, and 

hikes to Yosemite Falls and around the valley floor. You will thoroughly enjoy seeing his photographs 
and hearing his story.  
 
2. Dave Moore Bio- Dave began photography in his early years and continued through college. He 

enrolled in the Institute of Design at Illinois Institute of Technology, studying under famous 
photographers Harry Callahan and Aaron Siskind. He had work published in the Chicago Sun Times, 
the book Chicago’s Famous Buildings, and his college yearbook.  
 
After college he was commissioned through his college ROTC as a lieutenant in the US Air Force. He 
requested assignment in Aerospace Audio Visual Service and served in photography throughout his 
22-year Air Force career. During that time Dave served in Vietnam in the early days of the war, 
running the Air Force’s Combat Camera unit for Southeast Asia. He flew 52 combat missions as a 
supervisory aerial photographer. Later he served at Vandenberg Air Force Base as Operations 
Officer of the Photo Squadron, supervising photography of missile launchings. He also served in the 
Canal Zone of Panama, leading documentary photo operations and supporting Air Force activities 
through Latin America. Following his Air Force career, he was a Quality Engineer for Optical 
Radiation Corporation and then a salesman for the Vernon Company, selling promotional advertising 
products. 
 
Dave has been active in the Redlands Camera Club on trips, lectures, and meetings. He has 
attended photo workshops with Bob Killin, Ralph Nordstrom, Sandy Wheaton, as well as Lightroom 
and Photoshop courses from Scott Kelby, Frank Peele, and John Williams. 
 
Following Dave’s participation in and documentation of the Ferrari Club of California’s Yosemite 
Grand Tour IV, his photography was published in Sempre Ferrari, Ferrari Club of America Southwest 
Region Magazine, in the Nov.-Dec. 2019 issue. 
 

 
Photo credit: Marie Collins 
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Photogram Theme “Architecture” 

 

 

 

 

 

 

 

Photos by Rick Strobaugh 
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Photos by Debra Dorothy 
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You are invited to an Iceland Photo Workshop 

 By Robert Fletcher of Canon USA and Jeff Swinger of USA Today and Canon 

USA 

 

The workshop is geared towards waterfalls, Northern Lights, Glaciers, Ice Caves, 

Fjords, black beaches with 10,000-year-old ice and lots and lots of fun. 

 

The cost is $4999 for this 12-day workshop 

Feb 2 – 13, 2022 

 

The price includes:  

 Bob Fletcher & Jeff Swinger as your photo guides 

 Local Iceland Guide (so we don’t get lost!) 

 All transportation including pick-up and drop-off at the airport 

  (Super 4x4 vehicle with 46” tires) 

 All accommodations (double occupancy, single occupancy is $800 additional) 

 Breakfast 

 Ice Cave Tour with all safety equipment & crampons 

 Image Review and Post Production lessons, 

as time is available 

 

The price does not include: 

 Airfare to Iceland (around $800 - $900) 

 Travel insurance 

 Lunch & Dinners 

 Gratuity to our Iceland guide & driver 

  

If you have any interest in going or have questions, 

please call or e-mail me. 

 rrfletcher@gmail.com   

 

Cell: 951 202-4179 

 

I am only taking 12 people on this workshop and I anticipate the slots booking quickly. 

 

Bob Fletcher 

Jeff Swinger 

 

 

 

 

 

 

mailto:rrfletcher@gmail.com
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Here’s What I Think! 

This article covers different Adobe Photoshop/Lightroomtips and 

techniques.  The views expressed in this article are those of the author and 

do not necessarily reflect the views of Redlands Camera Club. 

By John Williams 

Need help?  If you have any questions about processing an image using Adobe Lightroom 

or Photoshop, email me at jhwr@earthlink.net (for RCC members only) and I will try to 

assist you. 

PHOTOSHOP TIPS 
What’s new In Photoshop V 22.5 (released August 17, 2021): 

 In this release there are new skies for the sky replacement feature, improvements to the Neutral Filter and 

many bug fixes and general stability improvements. 

 Save a Copy:  A new menu item makes it simper to save a copy of your work with a different name or file 

format.  Choose File>Save A Copy. 

 Improved neural filter.  When a filter is grayed out in Photoshop, t indicates that the filter is unavailable.  

Most filters in Photoshop have been updated to support mot image mode.  However, some filters only 

work with photos in the 8-bit per channel mode and some are only available for images in the RGB color 

space.  To change an image to 8-bit per channel mode, choose Image>Mode>8-bits/Channel.  If the 

image is not in the RGB Color mode, then choose Image>Mode>RGB color. 

Instantly FIX color in Photoshop. 

 If you have multiple layers use the shortcut key Ctrl+Alt+Shift+E (to flatten all the layers into one 

image).  If you don’t have multiple layers use the shortcut key Ctrl+Eon the Background Layer to 

duplicate the layer. 

 Choose Image>Adjustments>Match Color. 

 In the popup Match Color workspace (left figure below) check the Neutralize button and click OK.  To 

automatically remove a color cast in the target image, select the Neutralize option. Make sure that the 

Preview option is selected so that your image is updated as you make adjustments. 

 

 To make sure this adjustment only effects color and not luminosity, change the Blend Mode to Color. 

To control the amount of adjustment applied to the image, move the Fade slider. Moving the slider to the 

right reduces the adjustment. 

  

LIGHTROOM TIPS 
What’s New in Lightroom Classic 10.4 & Cloud Service (released August 17, 2021) 

 Updates for Lightroom Classic 10.4 and the Cloud ecosystem (desktop 4.4/mobile6.4) have been released.  

This is an interim release, so these are primarily for bug fixes and new camera support, but there are a 

couple of small enhancements to Classic. 

 Duplicate Collection Sets (Classic only):  Previously, there was no easy way to duplicate an entire 

Collection Set. Now, if you duplicate a Collection Set then all Collections in it are also automatically 

duplicated.  Right-click the Collection Set Name and from the popup list select Duplicate Collection. 

 Nikon Tethered Live View support (Classic only):  Tethered Capture with Live View support has been 

added for the Nikon D750 and Nikon D610. 

Add/Removing Keywords from Multiple Photos in Lightroom 

 In the Library module select the Grid view.  Select multiple images that you’d like to remove or add to 

the Keywords List by pressing the first image and shift click the last image in the series. OR you’d like to 

mailto:jhwr@earthlink.net
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select multiple images that are not next to one another, just depress the Control key and click the images 

you want to work with. 

 You’ll notice that the Keywording List panel (see figure below) holds all of the words that you have used 

in your catalog in alphabetical order. The words that you’ve tagged with the picture appear with a 

checkbox. If you want to add a keyword to the set, hover over the keyword you want to add and you’ll get 

a square to the left of the word, letting you check it. 

 Clicking on the checkbox will remove the keyword – taking the keyword off of the images that you have 

selected. 

 
Let Lightroom do its own backups of the Catalog 

 All of your edits are stored in the catalog, so keeping it safe is essential. There are four main things that 

can go wrong with your catalog: 

1. User error – you may accidentally remove photos from the catalog or unintentionally change settings. 

2. Hard drive failure – if you’re hard drive dies (or accidentally gets unplugged), you’ll need to restore 

your catalog from a backup on another drive. 

3. Catalog corruption – although rare, the database can become corrupted, usually due to hardware errors. 

4. Software bugs – all software has bugs even though it’s tested carefully. 

 By default, Lightroom prompts you to back up your catalog weekly when you quit Lightroom, and all you 

have to do is press the Back Up button in the dialog (see left figure below). Checking the Test integrity 

before backing up and Optimize catalog after backing up are sensible maintenance options to always 

check. 

 The Backup catalog is zipped using the current date/time in the folder name so you can identify it later. 

 To find the current Catalog name and file location choose Edit>Catalog Settings (see figure to the right 

below).  When you depress the show button you will probably see several Catalogs.  Note each time there 

is a major Adobe Lightroom update, a new Catalog will be made.  In the figure below note my current 

Catalog is v10.  Click the Show button will launch File Explorer and you will be able to see your current 

Catalog. 

 The backups are located under Lightroom (folder) and Backups (folder).  You’ll notice that Lightroom 

never deletes your older backups. You should delete older backups to free additional hard drive space. I 

would recommend keeping at least the most recent backups (2-3), in addition to some slightly older ones 

(e.g., 1 month, 6 months, 1 year), just in case you later discover you’ve accidentally overwritten some 

settings or removed some photos from your catalog. 

 

 Don’t forget, Lightroom’s catalog backup tool does NOT back up your photos or any of your presets. You 

still need a good backup system, in addition to Lightroom’s catalog backup system. 
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Photos by Judith Sparhawk 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



~ 20 ~ 
 

Announcements 
 

New – Personal Lightroom Coaching with John Williams 
 

Contact John Williams for some over-the-shoulder coaching in photo editing, a great way to learn. Using 

your selected images, John will work with you at your level to improve your understanding of key tools and 

techniques to make the most of your photos. John is a regular contributor of articles on Lightroom and 

Photoshop to the RCC Photogram. Reach John at jhwr@earthlink.net or talk to him at our meetings.  

 

RCC Members: Unique opportunity to make a difference 
Frank Peele, Education/Workshops Chair 

 

Museum of Redlands 

This newly-established museum needs quality photography of items in its collection, and has asked RCC 

for support. This sounds like a win-win situation, both for the museum and for our members who want 

to develop skills in “product” photography. I envision a workshop to teach the fundamentals, and one or 

more shooting sessions to get into creating great images for the museum’s use. If you’re interested in 

being part of this service to the community, or just want to find out more about the opportunity, shoot 

me an email: educationworkshopsrcc@gmail.com  Thanks, Frank 

____________________________________________________________________________________________________________ 

Film cameras and Lenses Needed  
 
A group of photo-enthusiasts at Riverside Community College needs FILM cameras and lenses to use in 

their studies. If you have such equipment you’re willing to donate to a worthy cause, please contact RCC 

member Constance St Jean and let her know what you have. Contact her by email at 

constancestjean@gmail.com 

_________________________________________________________________________________________________________ 

 

A 35 mm slide and negative digitizer, a Wolverine F2D, has been generously 

donated to the club by member Dave Knapp. It will produce a 7 mb JPEG 

digital image from your black and white and color slides and negatives. If you 

are interested in borrowing it from the club, email Wayne Purcell at 

waynepurcell72@gmail.com or text him at (909) 664-4365. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

mailto:jhwr@earthlink.net
mailto:educationworkshopsrcc@gmail.com
mailto:constancestjean@gmail.com
mailto:waynepurcell72@gmail.com
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In January the Redlands Camera Club lost one of its most memorable and 

valued members and a friend to all of us, Wayne (Woody) Wood. Woody 

loved all aspects of photography, whether on the ground or in the air, and 

was always getting new and exciting equipment (ooh, okay, toys).  

 

As a consequence, this has left Woody’s widow, Meredith, with equipment 

she can’t use. She has asked me to sell Woody’s equipment for her and 

hopes our members will help find good homes for Woody’s toys. 

 

The following is the first group of items.  The prices listed are negotiable but I feel they are 

reasonable as they represent a discount below the same or similar items, I saw on Ebay.  I 

believe all are in good working order. 

 

If you would like to provide a home for any of Woody’s toys, please contact me at 909-793-

9300 Bruce Bonnett 

 

Skydio R1 Autonomous 
Drone 4K Flying Camera with 
3 batteries and case 

 
$400 

 

Lilliput 665gl-70np/ho/y 7" 
On-Camera HD Color LCD 
Field Monitor w/HDMI In 
HDMI Out Component in 
Video in Video Out by Lilliput 
and 2 batteries 
https://www.amazon.com/Lilliput-665gl-70np-Camera-

Monitor-Component/dp/B005VH0UMU 

 

$75 

https://www.amazon.com/Lilliput-665gl-70np-Camera-Monitor-Component/dp/B005VH0UMU
https://www.amazon.com/Lilliput-665gl-70np-Camera-Monitor-Component/dp/B005VH0UMU
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LINKSYS WIRELESS-G 

2.4Ghz. ROUTER with 

SRX200 

$25 

 

Promaster 1725N 
Camera Bag 
 

$10 
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LoweproCompuDaypack 

Camera Bag 
 

$30 
 

 

Lowepro Inverse 200 AW 
Camera Beltpack 
 

$40 
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Top and left are for Mavic 
Drones 
Bottom right is for Skydio R2 
 

$10 

 

Ultimaxx DRONE BACKPACK 
STRAP VEST 

$20 
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MSI R9 390 8GB Video 
Card 
 

$175 

 

iMax X100 AC/DC 
Touch Screen Balance 
Charger 
 
$50 
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Garmin rv 770 GPS 
with 6.945” edge-to-
edge screen and RV 
specific features. 
 

$300 
 

 

GoPro/Action 
CamsMisc Bag 1 
$15 
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GoPro/Action 
CamsMisc Bag 2 
 

$15 

 

GoPro/Action Cams 
Misc Bag 3 
Includes a Removu RM-R1 Live View Remote 

for GoPro HERO3/HERO3+/HERO4 and 

GoPro Hero4 Session (Black) 

And a Hero 5 Macro lens 

The thing on the top is anbelt type of device to 

help support a heavy camera 

The gray item on the bottom is a mechanical 

pan head. 

 

$100 
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Pano 5+1 Mark 

II－Panoramic Photo 

Head Compatible with 
GoPro Hero 7/6/5/4/3 

$20 

 

Sevenoak SK-EBH01 
Pro Electronic Time 
Lapse/Panoramic Ball 
Head 
 
 
$75 
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Photogram Editor – Debra Dorothy 

 

A Note from The Photogram Editor 
 

 

The theme for the November Photogram is:  

 

“Still-life” 

 

 

Please send your images to me by October 25
th
 to have them included in the November Photogram for all to 

enjoy. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
mailto:debbiedsd.dorothy@gmail.com 
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